
MaximDL 

Kabelkologia - czyli co gdzie wetknąć i jakie kabelki sobie zlutować aby ruszyła maszyna  

Co potrzeba:  

Do działania podstawowego zestawu potrzebujemy :  

- komputer (może być bez portu COM, ale fajnie jak ma )  

- EOSa ( tu będziemy mówić o 350D )  

- Kabel USB łączący komputer z EOSem.  

- kabel do długich czasów  

Co do kabla do długich czasów w EOSie:  

- można sobie taki samemu zlutować i jest to proste jak drut ( sam mam taki i sprawdza sie najlepiej - 

polecam wersję z optoizolatorami na wypadek gdybyśmy chcieli kiedyś zasilać aparat z 220V za 

pomocą zasilacza CANON ACK 700 : http://www.twenga.pl/cena-ACK-700-CANON ... i-424343-0 )  

Lutujemy wg schematu ze strony http://www.covingtoninnovations.com/dsl ... lease.html  

- Kable takie produkuje także Happ Grifin - http://www.hapg.org/astrocables.htm  

- Kable takie sprzedaja też w sklepie Diffraction Limited - 

http://www.cyanogen.com/buy/DSLRcable.htm  

Kabel taki jest na porcie COM. Niestety nie każdy ma ten port w laptopie dlatego stosujemy 

przejściówkę COM->USB. Ja stosuje przejściówkę na czipie PROLIFIC i działa narazie doskonale. 

Przejściówki takie dostaniemy na allegro w cenie około 25zł. Niestety nie wszystkie przejściówki 

chcą wspópracować z różnymi urzadzeniami, dlatego należy uczulić się na tym czipa.  

Kabell USB i kabel do długich czasów proponuje połączyć razem - najlepiej taśmą izolacyjną 

(odradzam pasków elektrycznych - kable dzieki nim wspaniale lubią sie plątać ) - i tak rzadko kiedy 

stosuje się je oddzielnie - jesli ktoś planuje używać kabla USB do ściagania fotek "z wakacji" to 

raczej proponowałbym zaopatrzyc sie w oddzielne kable do fotek wakacyjnych i do astro.  

Kabel USB ma ograniczenie w długości - podobno do 5m działa to OK...mój ma 3m i nie ma żadnego 

problemu. Oczywiście fajnie jest mieć dłuzsze ze względu na możliwość odsuniecia sie kompem od 

focącego sprzętu dzięki czemu nie narażamy sprzętu na drgania od chodzenia ( dla mnie - focacego z 

tarasu jest to kluczowa sprawa )  

Polecam także zaopatrzyć się w kable kolory białego lub szarego - po prostu widać je w ciemnościach 

( ja tego nie zrobiłem i żałuje ).  

Ustawienia aparatu:  

1. W EOSie wchodzimy do Menu i ustawiamy typ komunikacji z kompem na PC CONNECTION 

 

1.  

http://www.twenga.pl/cena-ACK-700-CANON-La...omorki-424343-0
http://www.covingtoninnovations.com/dslr/CanonRelease.html
http://www.hapg.org/astrocables.htm
http://www.cyanogen.com/buy/DSLRcable.htm


2. Ustawiamy aparat na tryb MANUAL (M) 

 

3. Ustawiamy Auto Power Off na OFF 

 

4. Long Exposure Noise Reduction na OFF 

 

5. Review Time na OFF 

.... i to tyle jeśli chodzi o sam aparat. Nie ustawiamy żadnego ISO ani innych opcji, wszystkim 

będziemy sterować z komputera.  

 

2. Pierwsza fotka  

 

Sterownie aparatem za pomocą EOS Capture  

1. Podłączamy narazie tylko kabel USB do komputera i aparatu ( kabel do długich czasów będzie 

póżniej ), włączamy aparat, patrzymy czy w "Mój Komputer" znajduje się ikonka aparatu. 

Wyłączamy wszelkiego rodzaju kreatory zciagania fotek itp. 



 

2. Włączamy program Digial Photo Proffesional ( instalowany z płyty ze sterownikami Canona ) w 

którym uruchamiamy opcję Tools> Start EOS Capture. 

 

 

3. Jeśli wywala nam jakis błąd to sprawdzamy czy nie mamy przypadkiem włączonego Mirror 

Lockup.  

4. W programie klikamy sobie dowoli aby dośc co gdzie kiedy i jak. Jeśli wszystko działa jak 

powinno to jest duża szansa, ze w MaximDL też zadziała. 



 

O EOS Capture piszę gdyż czasem aparat z jakiegoś powodu nie chce się połączyć z Maxim'em. 

Wtedy w pierwszej kolejności sprawdzam czy aparat da się kontrolować za pomocą EOS Capture, 

jeśli sie nie daje to zwykle restartuje komputer i problem znika ( jakaś niezgodność sterowników 

występuje w moim komputerze czasem, nie wiem od czego to zależy ). Dlatego warto poświęcić 

chwilę na opanowanie tego softu, tym bardziej, ze to dobry wstęp do obsługi aparatu z Maxim'a. 

Łączenie aparatu z MaximDL  

1. Dalej mając aparat połączony z komputerem tylko za pomocą kabla USB ( ciągle bez tego od 

długich czasów ) włączamy Maxima.  

2. Klikamy na ikonkę "Toogle CCD Control" lub wciskamy Ctrl+W - jest to najważniejszy guzik w 

Maximie który odpowiada za kontrolę kamery/aparatu. 



 

3. Przechodzimy do zakładki "Setup" gdzie klikamy na guzik "Setup" w części "Main CCD Camera"  

4. W nowym okienku podajemy Camera Model -> Canon EOS 2, EOS Model -> 350D/Rebel XT, 

Shutter Release -> USB/FW Only, Image Mode -> RAW, Bulb Exposure -> 30 and over, Mirror 

Settle Time -> 1/10s 

 

6. Klikamy OK i w panelu "Setup" klikamy "Connect", czekamy chwilkę. Jeśli nie wywali żadnego 

błędu to jesteśmy połączeni z aparatem.  

6. Przechodzimy do zakładki "Expose" gdzie ustawiamy Type-> Light, Minutes->0, Seconds->5, 

Delay->0, ISO ustawimy sobie na ISO800 i wciskamy guzik "Expose"  

7. W tym momencie usłyszymy podnoszące sie lustro i obok wyboru ISO zobaczymy pasek 

postępu oraz poniżej tego tekst "Exposing Light". 



 

7. Jak skończy naświetlać pojawi się pasek postępu ściagania fotki po kablu USB z tekstem 

"Downloading Image". Jak fotka ściagnie się po kablu to czekamy jeszcze chwilę aby Maxim 

mógł sobie ją przemyśleć i pojawi sie ona nam na ekranie przy jednoczesnym wydawaniu 

dzwieku "ding". 

 

 

Drobna uwaga : Ściagnie fotki po kablu USB 1 trwa około 7s, po kablu USB2 około 3s. Natomiast 

myslenie nad fotką zajmuje na moim PIII 450Mhz około 12s, na Core2 Duo trwa to około 4s. Tak 

wiec na starym kompie w sumie fotka w pełnej rozdzielczości ściaga się około 15s, na nowym około 

7s.  

9. Mamy fotkę na ekranie - pierwsze koty za płoty ! Fotka jest teraz zaladowana do tempa 

Windowsów (chyba) i aby ją zapisać nalezy zrobić File-> Save (Ctrl+s) i zapisujemy do FIT'sa.  

 

Prawdopodobnie fotka jest ciemna, w jakąś brzydką kratkę i wogóle ma za duży kontrast - jak sobie z 

tym radzic będzie w następnym odcinku, po weekendzie.  

pozdrawiam 

5. Fotka powyżej 30s...  

 

1. W aparacie do gniazda od wężyka wkładamy kabel od długich czasów, kabel od USB nadal 

pozostaje.  

Drugi koniec kabla od długich czasów wtykamy do portu COM w komputerze. Jeśli nie mamy portu 

COM w kompie to musimy od razu zastosować przejściówkę COM->USB ( o którym była mowa w 

pierwszym rozdziale ) i docelowo ci co mają port COM pewnie też będą korzystać z takiej 



przejściówki, ale na dziś proponuje zlikwidować potencjalne źródła "nie-działania" czyli omijamy 

przejściówkę. 

 

PS.O przejściwókach będzie jeszcze mowa... 

2. W aparacie zmieniamy w Menu > Custom Functions (C. Fn ) > "07 Mirror Lockup" na "Enable" 

 

3. Włączamy MaximDLa, w okienku Toogle CCD Control-> zakładce Setup, w dziale Main CCD 

Camer -> Setup ustawiamy wszystko tak samo jak w poprzedniej wersji z wyjątkiem Shutter Release 

w którym podajemy numer portu COM na którym mamy podłączony kabel od długich czasów oraz 

przestawiamy "Mirror Settle Time" na 1s ( 2s to jak dla mnie za dużo, szczególnie gdy chcemy 

ustawić ostrość ). 



 

4. Jak nie wywali błędu to ustawiamy czas naświetlania na 5s i patrzymy czy wszystko jest OK. Jeśli 

zrobił fotkę to wstawiamy 40s i trzaskamy fotkę... jeśli też sie ściagnie to jesteśmy w domu.  

 

* Może sie zdarzyć, że fotka na czasach 5s bądź 40s wykona się - czyli podniesie sie lustro, naświetli 

i opadnie lustro, ale fotka nie będzie sie chciała ściągnąć - oznacza to, że w coś nie gra z kolejnością 

podłączania kabli ( czasem tak mam ) i należy wtedy spróbować wyłączyć aparat i włączyć ponownie 

- jeśli to nie pomoże proponuje restart kompa z włożonymi już kablami USB i COM i z wyłączonym 

aparatem który włączymy jak Windowsy już powstaną ( ta operacja zawsze skutkuje pozytywnie ).  

Jeślli po wciskaniu guzika "Expose" lustro wogóle nie podnosi się tzn, że mamy źle ustawiliśmy port 

COM lub mamy zwalony kabel do długich czasów.  

 

** Szczerze mówiąc teraz aparat już prawie zawsze rusza za pierwszym razem, ale na początku troche 

z tym walczyłem.  

 

*** Od strony technicznej współpraca aparatu z Maximem wyglada tak, że gdy podłączymy aparat do 

kompa tylko kablem USB to możemy robić fotki tylko do 30s a wyzwalanie migawki odbywa sie za 

pomocą kabla USB ( a'la software'owo ). Gdy podłączymy kabel USB + długie czasy to mozemy 

stosować dowolnej długości czasy naświetlania a za wyzwalanie migawki opdowiada już tylko kabel 

od długich czasów ( a'la hardware'owo ) i przestaje mieć znaczenie czy jest to 5 czy 45s ( dla testu 

odłączcie kabel od długich czasów i ustawcie 5s - lustro nie podniesie się )  

opcji.  

 

**** W programie EOS Capture nie możemy robić zdjeć na długich czasach z kablem do długich 

czasów - wogóle nie ma tam takiej opcji. 

4. Histogram - czyli jak zrobić, żeby jednak coś zobaczyc na ekranie.  

 

1. Ustawiamy sobie martwą naturę, najlepiej różno-kolorową.  

2. Trzaskamy jej fotkę kitowym obiektywem, w ciągu dnia, na czasie powiedzmy 0.5s ( najlepiej za 

pomocą kabla do długich czasów aby przyzwyczajać się do niego )  

3. Fotka ściągnie się nam na komputer i wyświetli. Robimy jej Ctrl+S aby zachować sobie do testów ( 

aparat mozemy już wyłaczyć - narazie nie bedzie potrzebny )  

 

Aby wam ułatwić zabawę fotka jaką ja używałem do tutoriala jest do ściągnięcia tu (15MB):  

- Martwa natura - http://philips.art.pl/astro/Martwa%20natura.fit  

 

OK. Ten rozdział jest szczególny... bo Maxim jest szczególny/inny niż zwykle to jest przy fotkach z 

DSLRów.  

http://philips.art.pl/astro/Martwa%20natura.fit


Generaluzując, użytkownicy zwykłych aparatów przyzwyczajeni są do tego, ze fotkę można sobie 

zobaczyć, pokazć "surówkę" itp.... Z Maximem to nie do końca tak jest. Tu nie ma "zwykłego 

zdjęcia".  

Maxim jest programem do astrofotografii, nie do robienia fotek marwtej natury. Dlatego też - i to jest 

własnie jego zaleta a nie wada - jest on nastawiony na oglądanie tych ciemnych partii fotki gdzie 

ukryty jest obiekt który fotografujemy. Dlatego też Maxim w zasadzie zawsze pokazuje nam fotkę już 

"podciągniętą", ze zestreczowanym histogramem.  

W pierwszej chwili odruchowo będziemy chcieli zobaczyć jak fotka wygląda "naturalnie", czyli z 

pełnym zakresem histrogramu ( czyli 0-4095 ADU czyli 12 bitów ) i histrogram będziemy rozciągali - 

nie ma to jednak sensu. Ale do rzeczy.  

 

4. Otwieramy okienko histrogramu (Ctrl+H )  

5. W okienku tym mamy dwa suwaki w histrogramie. Lewy dajemy w lewo, prawy w prawo. Pojawi 

nam sie cyferka zero i 4095 ( lub więcej, to nie ma znaczenia na obraz jak więcej ) a w liście 

rozwijanej pojawi nam się napis "Manual" ( możemy też z listy rozwijanej wybrać opcję Max Val ) 

 

W ten sposób mamy "normalny" obraz fotki jaką zrobilismy - pełny zakres tonalny. Jest to jednak 

martwa natura więc wszystko jest OK, w przypadku fotek astro zobaczymy tu jednak tylko kilka 

białych, brzydkich plamek które nawet nie przypominają gwiazdek.  

Do zdjęć astro służą trzy ustawienia zakresy histogramu: low, medium i high. Każda kolejna podbija 

kontrast wyświetlanej fotki. Jak widać na kolejnych screenach kontrast ten wzmacnia się dość mocno. 



- Low : 

 

medium 

 

High 

 

Jak widać między pełnym histogramem "Manual" a "Low" w przypadku martwej natury nie ma duzej 

różnicy. Przy Medium i High jest już duża i prawie nic nie widać.  

Nie należy tym się w żaden sposób zrażać bo tak ma byc... powtarzam, że jest to program do 

astrofoto, nie do dziennych fotek. Dlatego też wprowadźmy sobie tu drugi przykład - astro - czyli 

NGC_7000  - http://philips.art.pl/astro/ameryka%2028.04-002L600.fit  

W przypadku NGC_7000 obraz z "pełnym histogramem" w zasadzie nic nam nie pokazuje : 

 

http://philips.art.pl/astro/ameryka%2028.04-002L600.fit


W opcji Low już widac wyraźnie mgławicę: 

 

Natomiast w High widać wyraźnie niemal pełny zakres tego co nam się zarejestrowało z mgławcy, 

włącznie z ciemnymi partiami. 

 



Tak więc te trzy ustawienia histrogramu, zupełnie nie sprawdzające się w przypadku zdjęc martwej 

natury idealnie działają w przypadku zdjęć astro.  

 

Nie muszę chyba też nikomu udowadniać, że wygoda oglądania fotografowanego obiektu na 

monitorze w ciągu dosłownie 15s od opuszczenia lustra jest czymś wyjątkowo wygodnym. Dzięki 

temu można przede wszystkim wykadrować zdjęcie, ocenić panujące warunki, ocenić ostrość ( 

narazie "na oko" ) itp. Histrogram który na bierząco ocenia fotkę i dobiera odpowiednie parametry 

"przycinania" ( a robi to perfekcyjnie w moim odczuciu ) pozwala dokładnie określic gdzie znajduje 

się nasz obiekt i wogóle co tam jest/będzie. Szybkosć dzialania tej podstawowej funkcji jest dość 

dobra i zupełnie bije na głowę wszelkiego rodzaju inne metody kadrowania/podglądania zdjęcia.  

 

* Tak naprawdę to co robi Maxim to nie jest zwykłe przycinanie histogramu jakie zamy z 

Photoshopa>Levels. Jest to dość skomplikowane połączenie krzywych z Levelsami czyli działa chyba 

coś na kształt logarytmicznie. Funkcjonuje on na zasadzie procentów ciemnych i jasnych partii fotki.  

 

** Można sobie samemu skonfigurować parametry "przycinania" histogramu dla wartości Low, 

Medium i High. Szczerze mówiąc nie ma tu jednak nic do poprawiania. 

 

6. Funkcja Convert RGB - czyli widzimy świat w kolorach  

Mamy na ekranie fotkę czarno-białą, widzimy ją w wersji "nie wywołanej”, czyli de facto widzimy 

FITSa z maską Bayer'a. Chcemy zobaczyć jednak zdjęcie w kolorach.  

Służy do tego guzik RGB Convert: 

 



W okienku mamy kilka ustawień. Ogólnie chodzi w nich o to, aby ustawić balans bieli. Część operacji 

wykonuje się automatycznie, a część musimy sami wpisać. Ta część należąca do nas to określenie 

stosunku koloru czerwonego do zielonego i niebieskiego.  

1. Na początek zaznaczamy ptaszki przy X Offset i Y Offset oraz zostawiamy wartości 100 przy 

kolorach 

 

2. W przypadku martwej natury, na histogramie w wersji LOW fotka wyjdzie nam mocno 

przekontrastowana - rozciągamy histogram do "Max Val" 

 

Jak widać, kolory są zupełnie nietrafione. To dlatego, że balans bieli jest "prosto z matrycy". Tego 

ustawienia będziemy używać później. Teraz jednak chcemy mieć fotkę w normalnych kolorach.  



3. Wciskamy Undo (Ctrl+Z) i znów RGB Convert. W ustawienia wpisujemy wartości podane w 

Helpie Maxima ( w Helpie wpiszcie "Convert RGB" w "szukaj" i na samym dole opisu znajduje się 

tabelka z wartościami dla różnych aparatów): 

 

 

Ja wybieram wartości R-194 G-100 B-135 bo mam EOSa 350D. 

 



W tym momencie każdy nieprzerobiony EOS 350D pokaże "prawdziwe" kolory i to już jest koniec 

zabawy...Mamy zdjęcie wywołane.  

Niestety (stety) mój aparat jest zmodyfikowany, czyli mam wymieniony filtr w aparacie na Baaderowski 

w związku z czym typowy balans bieli został zachwiany i ustawienia z Helpa nie sprawdzają się: 

 

I tu zaczyna się zabawa.... musimy dobrać odpowiedni dla naszego aparatu balans, co generalnie do 

łatwych nie należy. W przypadku tej martwej natury najbliższe rzeczywistości kolory uzyskałem przy 

ustawieniach:  

R-105  

G-100  

B-135 

 



Ponieważ z bliżej mi nieznanego powodu histogram przy tej operacji ma tendencję do poszerzania się ( a 

tym samym białe fragmenty nabierają brzydkiego przebarwienia ), więc należy sprowadzać jego górną 

wartość do okolic 4095 ręcznie. 

8. Ustawiamy ostrość - podstawy ....czyli zakładka Focus i Inspect  

 

To chyba najważniejszy rozdział. Wszystkim początkującym jak i czasem zaawansowanym 

użytkownikom DSLRów ustawianie ostrości sprawia duże problemy. Maxim DL w tej czynności 

bardzo nam pomaga dzięki czemu staje się ona w sumie bezstresowa, łatwa, szybka i przyjemna.  

 

1. Mamy podłączony aparat do kompa, zostalo nawiązanie połączenie z Maximem, fotki sie 

zciągają.  

 

UWAGA: Ustawiamy teleskop na gwiazdę o jasności 4-5mag, najlepiej na 4,5mag !!! 

Gwiazda oczywiście nie moze być gwiazdą podwójna !!!  

 

2. Robimy zdjecie na czasie naświetlania 1-3s ( w zalezności od jasności, ja przy F5.6 robie na 2s 

)  

* Do celów tutoriala posłuże się kamerą "Simulator" dostępną wsród innych kamer w zakładce 

Setup->Main CCD Camera  

 

3. Otwieramy zakładkę Focus 

 

Mamy tu kilka ustawień. Jedną z nich jest wielkość obrazka ( w Symulatorze rozdzielczość matrycy 

to 768x511 ), czas naświetlania, binnig etc.  

Najważniejszą w tym okienku rzeczą jest jednak zaznaczenie obszaru gwiazdy kwadracikiem : 



 

Po zaznaczeniu gwiazdki ustawią nam sie w Subframe wielkość w pixelach zaznaczonego 

kwadracika.  

 

4. Wciskamy Focus 

 

Co nam to daje ? A no jak juz wspominałem w którymś z poprzednich rozdziałów czas zciągania fotki 

w pełnej rozdzielczości trwa około 3s a "myślenie" nad tą fotką około 10s w zależnosci od prędkosci 

komputera.  

DSLRy nie mają opcji subframe'a czyli nie da sie z nich ciągnąć kawałka zdjecia tak by zciąganie 

trwalo krócej. Tak więc za każdym razem po kablu do kompuetra płynie pełne zdjecie te 3s. Jednak 

większą część czasu zajmuje tak naprawdę "myślenie" nad fotką. I tu z pomocą przychodzi nam 

własnie zaznaczanie kwadracikiem kawałka zdjecia dzięki czemu komputer myśli tylko nad tym 

kawałkiem. Ja zwykle wybieram obszar o wielkosci 150x150 pixeli i myślenie nad takim kawałkiem 

komputerowi zajmuje już tylko 1-1,5s ( nawet na PIII 450Mhz ).  

Dzięki temu mamy: naświetlanie 2s + zciaganie 3s + myślenie i wyświetlenie 1s = 6s .... Co 6s mamy 

nową fotkę gwiazdki .... istny karabin maszynowy jak na cele wyostrzenia aparatu typu DSLR.  

 

 



5. Zaznaczamy ptaszkiem opcję Continous, wciskamy Start Focus i przechodzimy do zakładki 

Inspect: 

 

6. Mamy tu kilka parametrów gwiazdy oraz jej "wygląd" 3D. Jeśli gwiazda ma zcięty czubek to 

znaczy, że jej jasność osiągneła maxymalną jasność naszej kamery (4095ADU ) i nalezy skrócić czas 

naświetlania. Gwiazda powinna mieć wykresik z łagodnym czubkiem - wtedy inne parametry będą 

podawane bardziej wiarygodnie. 

 

Kolejne parametry gwiazdki to:  

- Max X - pozycja gwiazdy w osi X  

- Max Y - pozycja gwiazdy w osi Y  

- Max Pixel - UWAGA - wartość najjaśniejszeg pixela w gwieździe - to powinno być mniejsze niż 

maxymalna wartość dla naszego aparatu czyli mniej niż 4095 - jeśli osiąga 4095 skracamy czas 

naświetlania.  

- FWHM - parametr określający ostrość - im niższy tym lepiej  

- Half Flux Dia. (lub "1 FD" w Large View) - parametr określający ostrość - im niższy tym lepiej  

 

Tak wiec:  

1. Patrzymy czy gwiazdka jest nie za jasna ( wg Max Pixel )  

2. Zaczynamy ostrzyc teleskop patrząc na na FWHM lub Half Flux Dia. Ponieważ podobno HFD jest 

bardziej precyzyjny w określaniu ostrości od FWHM więc propnuje własnie na nim sie skupiać.  

 

 



Mamy teraz kilka przypadków:  

a ) mamy wyciąg z mikroruchami, nie mamy motofokusa.  

1. Klikamy sobie zatem na guzik "Large View" dzięki czemu wyskakuje nam wielgachne okno z 

jeszcze większymy napisami ( wcześniej zaznaczamy w zakładce "Focus" ptaszek przy "Continous" ) 

i klikamy na "Start Focus" 

 

2. Obracamy monitor w stronę teleskopu  

3. Gapiąc sie na monitor kręcimy ręcznie mikroruchami w wyciągu aż wartości FWHM lub/i HFD 

będą najniższe z tych jakie odnotowaliśmy ( szkoda, ze nie ma do tego wkresów )  

Niestety dotykając teleskop wprowadzamy go w drgania, wiec proponuje w czasie jednego 

naswietlania dokonywać korekt a podczas drugiego nie dotykać teleskopu czekając na wyniki.  

 

b ) Mamy motofokus klasy "chińskiej" z guzikami  

1. Też włączamy duży Large View i postępujemy jak wyżej, ale korekty możemy dokonywać podcza 

zciągania i wyświetlania fotki - mamy na to jakieś 3-4s więc jest OK bo korekty i tak muszą być 

minimalne w swej końcowej fazie.  

 

c ) Mamy motofokusa sterowanego z komputera ( np motofokus LJ )  

Robimy wszystko jak wyżej, ale nie podnosząc tyłka z krzesła, nie trącając kablami teleskopu i na 

dodatek robimy to o określoną ilość kroków tak więc wyniki są powtarzalne a krzywa zmian ostrości 

przewidywalna. Robimy to za pomocą oprogramowania dołączonego do motofokusa.  



 

d ) Mamy Robofocusa  

1. Nie wychodząc z maxima uruchamiamy okienko "Toggle Telescope Control (Ctrl+T) i 

przechodzimy do zakładki Setup: 

 

2. Wybieramy wcześniej zainstalowany na naszym komputerze program "Robofocus Program"  

3. Nawiązujemy połączenie z Robofocusem ( to jest oddzielny problem na oddzielny tutorial ). 

Program wyskoczy nam na ekranie ale minimalizujemy i ignorujemy - będziemy Robofocusem 

sterować z poziomu Maxima ( choć mozemy też z poziomu programu Robofocus i efekty będą 

widoczne tez w Maximie - pytanie tylko po co komplikować sobie życje )  

4. Przechodzimy do zakładki "Focuser" i tam korzystając z opcji ustawiania pozycji Absolute 

ustawiamy wyciąg w ostatniej pozycji w jakiej teleskop mieliśmy wyostrzony ( u mnie jest to zwykle 

około 1410 )  

5. Ustawiamy sobie wartość w Icremental na określoną ilość kroków ( ja korzystam ze skoków o 3 

kroki ) i podczas zciągania fotek na komputer i "myślenia" nad nimi przestawiam wyciąg o określoną 

wyżej ilość kroków patrząc jaki to ma wpływ na HFD ( przestawienie o 3 kroki zajmuje około 0,5s, 3 

kroki to u mnie około 0,05mm wysuwu wyciagu (długość do sprawdzenia) )  

 

Binning  

Ktoś powie: Fajnie... ale ja mam tak nie wostrzony teleskop, ze daleko mi do "mniej wiecej obrazu 

gwiazdki", właściwie to wyciag jest w tej chwili całkowicie wysunięty/wsunięty i na czasach 2s 

widze tylko czarny ekran" a nie mam Robofocua ani nawet podziałaki nadrukowanej na wyciągu i nie 

pamiętam w jakiej pozycji obraz jest mniej wiecej wyostrzony.  

Maxim i z tym sobie poradzi....  

 

DSLRy nie posiadają, jak dedykowane astro-kamery, opcji binnigu ( binnig to inaczej łączenie 

sąsiadujących pixeli w jeden większy pixel o podwójnej czułości i połowie wielkości pełnej klatki co 

umożliwia krótsze czasy naświetlania i dwa (lub wiecej ) razy mniejszy obrazek ). Jest jednak w 



Maximie możliwość stosowania semi-binningu z DSLRami.  

Zmieniając binnig w zakładce "Focus" na cyferkę dwa, lub zaznaczając ptaszek przy opcji "Fast" 

wprowadzamy naszego EOSa w stan podwójnie zmniejszonej rozdzielczości z kompresją JPG. 

 

Dzięki temu fotka w pełnej rozdzielczości ( w sensie pracy całej matrycy a nie wybranego obszaru 

zaznaczeniem ) zciąga sie znacznie szybciej - około 2-3s wraz z "myśleniem" nad nią. Niestety nie 

wzrasta przy tym czułość aparatu, więc i tak musimy zwiększyć czas naświetlania.  

Ustawiamy sobie zatem czas naświetlania na 5-10s i patrzymy co nam się pokaże. Jak widzimy duże 

okragłe rozjaśnienie na fotce to znaczy, że mamy naszą gwiazdkę. Kręcimy wyciągiem aż stanie się 

ona stosunkowo punktowa i wtedy przełączamy binning na 1 ( lub wyłączamy ptaszek przy Fast) 

przechodząc tym samym na tryb RAW, trzaskamy jedną pełną klatke i zaznaczamy na niej obszar o 

wielkości ~150x150 pixeli.  

 

---- tu obrazek ktory trzeba zrobić pod niebem a nie na symulatorze ----  

 

* Z jakiegoś powodu obraz w wersji "binningu" lub Fast jest jakiś wyjątkowo "brzydki" i poszarpany 

- nawet ustawianie kadru za pomocą tej opcji w moim mniemaniu nie zdaje egzaminu. Niemniej do 

bardzo zgrubnego wyostrzenia nadaje sie dość dobrze.  

** W symulatorze kamery opcja Fast jest nie aktywna, z DSLRem zapewniam, że jest  

*** Między binnigiem 2x a opcja Fast nie ma żadnej różnicy - efekt daje dokładnie ten sam  

**** Ustawianie binningu na 3x lub 4x nic nie daje w przypadku DSLRów ( do sprawdzenia )  

 

Delay  

W zakładce "Focus" mamy jeszcze opcję - Delay - czyli jak długie mają być przerwy między jednym 

a drugim naświetlaniem klatki z gwiazdką. Kiedy mamy zaznaczony ptaszek przy Continous to fotki 

robią się jedna po drugiem a my akurat nie mamy motofokusa lub działa on bardzo wolno i 

chcielibyśmy mieć więcej czasu na pokręcenie wyciagiem nim zacznie naświetlać się następna fotka. 

Właśnie opcja Delay nam to umożliwia - ustawiamy sobie tu ze 2-3s i łącznie z czasem ściagania 

fotki i "myśleniem" nad nia mamy w ten sposób około 6s na kręcenie wyciągiem i czekanie na 

"wyciszenie" drgań przed następnym naświetlaniem... lepsze karabin maszynowy ze strzałem co 9-

10s niż karabin w którym co drugi strzał jest chybiony ( czyli gwiazdka rozdygotana od dotykania 

teleskopu ).  

 

Dark  

W zakładce "Focus" można sobie zrobić darka do klatek związanych z ostrzeniem. Szczerze mówiac 

nie używam tego, bo zwyczajnie nie chce mi sie po ciemku szukać dekla od teleskopu a dark do 



klatek 2-4s wydaje mi się, ze raczej mało daje. Może w SBIGach gdzie darki robi się łatwo z powodu 

wbudowanej migawki mozna pokusić się o taki luksus jak dark do ostrzenia (proszę mnie sprostować 

jesli plote tu bzdury z tymi darkami i SBIGami )  

 

 

 

I to tyle... aż tyle.... jeśli chodzi o najprostrze wyostrzenie DSLRa. Mi proces ostrzenia zajmuje około 

3-5 min przy czym korzystam z Robofocusa używanego w trybie opisanym powyżej, jednak nie 

stosuje Maximowego Autofocus'a ani FocusMaxa o czym będzie w ostatnim rozdziale.  

Ktoś powie - ja tez jestem w stanie wyostrzyć aparat w 3-5min....OK... fajnie... ale czy aby na pewno 

jest on wyostrzony w przysłowiowy punkt ? Różnica miedzy gwiazdką o FWHM 5 a FWHM 6 

naprawdę jest mała i w powiększeniu 100% jest niemal nie widoczna... a jednak wszyscy 

astrofotografowie walczą niemal o dziesietne części FWHM.... Tylko cyferki sa w stanie powiedzieć: 

"Tak, teraz masz telepa wyostrzonego...." a dzieki Maximowi jest to nie dość, że łatwe to jeszcze na 

dodatek skuteczne. Nie ma tu miejsc na "zgadywanie".... tu jest pewność .... 

Robimy Flaty - funkcja LINE PROFILE  

 

Jako przykład posłuży mi klatka do ściągnięcia tu (15MB): 

http://philips.art.pl/astro/ameryka%2028.04-030F.fit  

 

Flat frame z założenia ma być zdjęciem wykonanym z dowolnym czasem naświetlania na jakimś 

równo oświetlonym/świecącym ekranie mający na celu zlikwidowanie ze zdjecia winietowania i 

paprochów ( popularnie nazywanymi z ang donut'ami (dołnat) od okrągłego pączka ).  

Zrobienie dobrego flata jednak wcale nie łatwe - po pierwsze trzeba mieć ekran a po drugie 

odpowiednio go oświetlić. Generalnie rzecz ujmując należy tak naświetlić klatkę flata, aby w środku 

jego kadu jasność wynosiła 30-50% skal szarości dostępnych w aparacie a balans kolorów RGB byl w 

stosunku 1:1:1.  

 

DSLRy zwykle mają 12bitową głebie koloru czyli 4095 odcieni szarości. Flat zatem powieniem mieć 

jasność 1200-2000ADU. Tylko jak to zmierzyć ?  

Metod jest dużo i w wielu programach da się to zrobić ( np IRIS komenda >stat ) ale otwieranie za 

każdym razem fotki aby sprawdzić, czy klatkę flata odpowiednio naświetliliśmy jest jednak 

kłopotliwe.  

Maxim w tej materii ma zdecydowanie więcej do powiedzenia.  

 

1. Otwieramy lub naświetlamy klatkę flata, rozciągamy histogram na 0-4095 ADU - widzimy szarość.  

2. Klikamy na ikonkę "Toggle Information" (Ctrl+I)  

3. Wyskakuje nam okienko z całym mnóstwem informacji. Nas jednak interesuje aktualnie tylko 

parametr "Pixel" - jasność pixela. Najeżdżamy myszką na fotkę, kursor zmienia się w celownik. 

http://philips.art.pl/astro/ameryka%2028.04-030F.fit


 

Wartość wynosi coś w okolicach 1800 czyli jest OK.  

Z innych parametrów w przypadku flata możemy być zaintersowani jeszcze Minimum i Maximum ( 

minalna i maxymalna jasność pixela pod celowanikiem ).  

Fajnie...ale to sa opcje dotyczące jedynie tego co jest pod celownikiem i wartości ciągle sie wahają 

między 1200 a 1900ADU a my chcemy uśrednione wartości z jakiegoś obszaru.  

4. Otwieramy zatem kolejne okienko z rozwijanego menu View>Line Profile Window : 

 



5. Otwiera nam sie okno z miejscem na wykres. Rozciagamy je na pełną szerokość ekranu, 

wybieramy z listy rozwijanej Horizontal Box i zaznaczamy na fotce prostokąt w połowie jej 

wysokości : 

 

Rysuje nam się wykres rozłożenia jasności pixeli zaznaczonych na fotce - pixele są uśrednione 

pionowo z zaznaczenia. Jak widać moja optyka z jakiegoś powodu winietuje nie osiowo. Jednak flat 

jest naświetlony poprawnie bo środkowy "szczyt" wykresu oscyluje na osi Y w okolicach 1800ADU.  

6. Jesli środek kadru (szczyt wkresu) jest za jasny (powyżej 2000ADU) to nie zamykająć okna Line 

Profile ani nie zmieniając zaznaczenia naświetlamy flaty dotąd, aż jasność będzie odpowiednia.  

7. Jesli już jesteśmy przekonani, że jasność jest OK to nic nie zamykając klikamy na już nam znany 

guzik RGB Convert.  

 

 

 

 



UWAGA: Wpisujemy wartości dla balansu bieli R-100, G-100, B-100 oraz klikamy Reset w dziale 

Background Level : 

 

Balans bieli musimy mieć ustawiony na "prosto z matrycy" bo chcemy sprawdzić, czy aby napewno 

wszystkie pixele maski Bayer'a RGB naświetliły sie z tą samą jasnością. Jeśli zostawilibyśmy 

ustawienia stosowane przy "wywoływaniu" zdjęć (zbalansowane) doszło by do przekłamania 

prawdziwych wartości jasności ADU pixeli z filtrami RGB na naszej matrycy.  

8. Po "wywołaniu" zdjecia na wersję kolorową naszym oczom ukazuje się wykres Line Profile z 

kanałami RGB : 

 



Jak widać na załączonym przykładzie, flat został wykonany zdecydowanie niepoprawnie - kolor 

czerowny jest dużo za jasny, niebieski zbyt ciemny. Oznacza to, że albo ekran na którym 

naświetlałem flata był w raczej ciepłym kolorze, lub źródłow światła zbyt czerowne. Wykresy 

powinny mniej więcej nakładać się na siebie.  

Wykresy RGB są tak od siebie oddalone jak bardzo szeroki jest wykres jasności ADU przed 

"wywołaniem" zdjecia. Można stąd wyciągnąć wniosek, że im węższy będzie wykres w RAW tym 

bardziej nakładać się będą na siebie wykresy RGB co jest już pewną podpowiedzią przy naświetlaniu 

flata : 

 

Funkcja Line Profile jest bardzo użyteczna także do innych czynności jak określanie LP, 

prawdziwego ( nie rozciagniętego histogramem ) kontrastu fotki z obiektem, jasności tła (nieba), 

winietowania, gradientu od LP itp. Generalnie narzędzie to jest bardzo wszechstronne i niezwykle 

pożyteczne podczas całego procesu focenia, kalibracji i stackowania.  

 

* UWAGA: Przy "wywołaniu" zdjecia na kolorowe, jasności ADU fotki zmieniają się (pewnie z 

powodu uśredniania przy wywoływaniu - w sumie nie wiem czemu, zgaduje) i fotka staje sie 

ciemniejsza. Nie powinniśmy sie tym raczej przejmować bo interesuje nas jasność pliku RAW który 

to pokazuje faktyczną jasność pixeli matrycy która de-facto jest matrycą czarno-białą z kolorowymi 

filtrami na każdym pixelu. 

9. Tworzymy sekwencje focenia - zakładka Sequence  

 

W materii tworzenia sekwencji nie mam zbyt wiele do dodania względem opisu Jacka_Pali ( 

http://www.astronomia.slupsk.pl/MaxImDL_Tutorial/6.aspx ) z wyjątkiem tego szczegółu, że 

DSLRy nie mają mechanicznej przysłony jak kamery dedykowane do astrofoto. Dlatego niestety 

nie można zautomatyzować robienia klatek DARK i BIAS bez naszej ingerencji.  

Jeśli ustawimy sobie w sekwencji zdjęć do wykonaania najpierw Light'y a potem Darki/Biasy to 

przed przystąpieniem do wykonywania tych drugich wyskoczy nam okienko "Please Cover 

telescope" ( załóż dekiel ) i póki nie wciśniemy guzika OK po założeniu dekla dotąd nie zaczną 

sie one robić.  

http://www.astronomia.slupsk.pl/MaxImDL_Tutorial/6.aspx


Następna sprawa to fakt, że DSLRy nie mają termometru ( a tym bardziej chłodzenia ) jak 

dedykowane kamery, więc nie zapisuje się w danych EXIF fotki temperatura przy której fotka 

była wykonywana. Dlatego warto jest mieć pod rękę termometr i już przy ustawianiu sekwencji 

dopisać do nazwy obrazków jakąkolwiek wzmiankę o obecnie panującej temperaturze - tak na 

wszelki wypadek - nic to nie kosztuje i zajmuje jakieś 10s ze sprawdzeniem temperatury, a może 

nam potem trochę ułatwić sprawę.  

1. Przechodzimy do zakładki Sequence, wpisujemy nazwę foconego obiektu.  

2. Klikamy na Set Destination Path i podajemy folder dokąd mają być zapisywane wszystkie 

klatki.  

3. Klikamy na Setup Sequence : 

 

4. Podajemy nazwę klatki Light - proponuje L600s15C800 - czyli Light o długości 600s przy 

15Celsiusza i przy ISO 800 - te same dane zawarte są w EXIF ( które w Maximie nazywa się FITS 

Header ) z wyjątkiem wspomnianej temperatury. W nazwie pliku będzie się oczywiście znajdował 

przedrostek NGC_7000.  

Analogicznie do Biasa dajemy B15C800, do Darka D600s15C800 i do Flata F0,5s15C800. 

 



5. Jeśli nie chce nam sie wpisywac ręcznie ilości klatek dla poszczególnych typów to możemy sobie 

zaznaczyć opcję "Same Repeat Count For All" i podając w jednym miejscu ilość automatycznie ilość 

ta sama sie wpisze w reszcie ( mało przydatne przy DSLRach kiedy liczy się czas a chmury 

przewijają sie po niebie )  

6. Zaznaczamy też "Delay Between" ( zwłoka między naświetlaniem kolejnych klatek ) na 0 dla 

zaoszczędzenia cennych sekund.  

7. Kiedy już jesteśmy pewni wprowadzonych parametrów klikamy na guzik Start w zakładce 

Sequence i idziemy spać...klatki same się zapiszą do wskazanego folderu a podczas focenia ostatnia 

wykonana fotka znajdować się będzie na ekranie. 

11. Organizacja klatek do kalibracji - czyli jak sobie poradzić z temperaturą  

 

Jak wspomniałem w poprzednim rozdziale, DSLRów główny problem to brak jakiejkolwiek kontroli 

temperatury. Niestety nie ma też termometra jak w kamerkach DSI dzięki czemu możemy chociaż 

zawierać w pliku obrazka, w tzw EXIF a raczej FITS Header informacji o panującej temperaturze. 

Obejściem dość prymitywnym tego problemu jest dopisywanie temperatury do nazwy klatek.  

OK.. fajnie... ale co jak sesja ma kilka godzin i zaczyna się zaraz po zachodzie słońca kiedy jest 

jeszcze ciepło, potem w nocy kiedy temperatura spada, a potem naświetlamy nad ranem darki kiedy 

słońce powoli wstaje i rośnie znów temperatura. Spoglądanie ciągle na termometr jest nie dość, ze 

uciążliwe to jeszcze budzi niepokój jeśli chodzi o możliwość pomyłki.  

Trzeba to zautomatyzować ....  

a potrzebny w tym celu będzie nam termometr podłączony do komputera i zapisujący w jakiś sposób 

logi z temperaturą.  

Termometr:  

Na stronach :  

- http://grzesiek21.republika.pl/termo.htm  

- http://www.mod-planet.com/index.php?mod ... pageid=293  

- http://ocforum.pl/showthread.php?t=8401  

- http://termik.ok.9x.pl/articles.php?id=7  

znajdują się schematy tego samego termometru opartego o ten sam czujnik temperatury ( DS1820 / 

DS18B20 / DS18S20 - który kolwiek z nich, wszystkie działają tak samo). Koszt wszystkich części 

mieści się w 10zł. Całe lutowanie jest dziecinnie proste i zajmuje maxymalnie 1H. Mój wygląda tak: 

 

http://grzesiek21.republika.pl/termo.htm
http://www.mod-planet.com/index.php?module=subjects&func=viewpage&pageid=293
http://ocforum.pl/showthread.php?t=8401
http://termik.ok.9x.pl/articles.php?id=7


To czarne na drucikach to jest właśnie czujnik temperatury ( wyglada jak jakiś tranzystor ). Jest on na 

tych drucikach ponieważ gdy znajdował się wewnątrz obudowy wtyczki COM to prawdopodobnie 

wyłapywał temperaturę od nagrzanego komputera i wskazywał o 3-4 wiecej niz inne termometry w 

pokoju. Druciki o długości 5cm załatwiły sprawę.  

 

Niestety druciki nie są dobrym rozwiązaniem ( bo w nocy zaraz czujnik urwiemy niechcący ) - lepiej 

jeśli czujnik ukryty by był we wtyczce - można to osiągnąć dzięki zastosowaniu przejściówki COM-

>USB ( np na czipie Prolific z którą to termometr działa - już sprawdziłem - kolejna taka juz do mnie 

jedzie ). Wtedy termometr mozemy umieścić nie dość że na USB to jeszcze daleko od ciepłego 

komputera ( np na Hubie USB ).  

 

Gdy termometr jest gotowy ściagamy oprogramowanie. Softów do obsługi jest conajmniej kilka, 

jeden jednak przypadł mi najbardziej do gustu - Lampomittari - http://termik.ok.9x.pl/. Prócz tego, że 

jest on brzydki i ma jakieś zbędne bajery to ma jedną zasadniczą zaletę - tworzy logi z temperaturami 

do których jest bardzo łatwo i wygodnie wrócić.  

 

Ustawienia programu: 

 

http://termik.ok.9x.pl/


 

 

 



 

Wejście do logów z temperaturą: 

 

Wyskoczy nam wykres z zarejestrowaną temperaturą. Przeglądanie wykresów jest lekko uciążliwe ale 

da sie to zrobić. Jest w opcjach programu kilka opcji ułatwiających.  

 

Ponieważ program należy do tych raczej "dziwnych" swym działaniu wiec minimalizujemy go i 

zapominamy, że nawet działa.  

 

FITS HEADER  

OK... no fajnie. Wiemy już która klatka w jakiej temperaturze była wykonywana. I co dalej ?  

Maxim ma tą cudowną właściwość, że podczas kalibracji dzieli fotki kalibracyjne ( Darki, Biasy i 

Flaty ) wg czasu naświetlania, ISO ale także i wg temperatury. Niestety jak juz pisalem wcześniej 



danych o temperaturze nie ma w FITS Header. Jeśli jesteśmy wystarczająco stuknięci na punkcie 

astronomii to mozemu się pokusić o dopisanie temperatury do klatek kalibracyjnych tworząc tym 

samym całkiem niezłą bibliotekę takich klatek które później będzie można wykorzystywać ponownie.  

Zaczynamy od odpowiedniej organizacji folderów: 

 

Jeśli już mamy je pokatalogowane wg temperatury to w zasadzie nie potrzebujemy edytować FITSa, 

ale byc może nie będzie nam się chciało tego tak układać....  

1. Otwieramy Maxima  

2. Otwieramy nasze Darki/Biasy/Flaty  

3. Otwieramy dla każdej kolejnej fotki kalibracyjnej okienko z danymi zdjęcia View -> FITS Header 

Window(Ctrl+F) : 

 



4. Mamy tu wypisane wszystkie dane dotyczące zdjęcia. Informacji jest tam naprawdę dużo ( 

gdybyśmy sterowli montazem z poziomu TheSky'a to dopisane zostałyby współrzędne RA i DEC 

foconego obiektu ) włącznie z :  

- data, czas ( dopisywane automatycznie ), ważna sprawa ....  

- ISO ( dopisywane automatycznie )  

- czas naświetlania ( dopisywane automatycznie )  

- optyka ( trzeba podać w maximie w File-> Settings)  

- aparat ( dopisywane automatycznie )  

- ogniskowa ( trzeba podać w maximie w File-> Settings)  

- rozmiar pixela ( dopisywane automatycznie )  

- licencja Maxima  

- itd ...  

5. Przechodzimy do zakładki Edit:  

6. Z listy rozwijanej Key-Name wybieramy wartości CCD-TEMP i SET-TEMP i wpisujemy w 

okienku Value wartość naszej temperatury zatwierdzając guzikiem SET ( dla ułatwienia proponuje w 

liście rozwijanej wklejać napis CCD-TEMP aby automatycznie przewijała sie ona do tej pozycji ) 

 



 

Kiedy tak już dopiszemy do wszystkich klatek temperaturę to w okienku kalibracji w Maximie 

będziemy mogli cieszyć się takim ekranem: 

 

Dzięki temu możemy zaznaczyć folder z wszystkimi klatkami kalibracyjnymi i zaznaczyć ptaszek 

przy Include Subfolders pozwalajac Maximowi samemu dojść do tego które klatki najlepiej sie nadają 



do kalibracji poszczególnych fotek tak jakby to się działo w przypadku dedykowanej kamery do 

astrofoto: 

 

http://www.astromaniak.pl/viewtopic.php?f=14&t=5382 
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